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License Agreement

Important!   Please read this licence agreement carefully before opening 
the disk seal! Opening of the disk seal and use of this package indicates 
your agreement to the following terms and conditions. Emagic grants you 
a non-exclusive, non-transferable license to use the software in this 
package.

You may:

1. use the software on a single machine.
2. make one copy of the software solely for back-up purposes.

You may not:

1. make copies of the user manual or the software except as expressly 
provided for in this agreement.

2. make alterations or modifications to the software or any copy, or 
otherwise attempt to discover the source code of the software.

3. sub-license, lease, lend, rent or grant other rights in all or any copy to 
others.

Except to the extent prohibited by applicable law, all implied warranties 
made by Emagic in connection with this manual and software are limited 
in duration to the minimum statutory guarantee period in your state or 
country from the date of original purchase, and no warranties, whether 
express or implied, shall apply to this product after said period. This 
warranty is not transferable-it applies only to the original purchaser of the 
software. Emagic makes no warranty, either express or implied, with 
respect to this software, its quality, performance, merchantability or 
fitness for a particular purpose. As a result, this software is sold “as is”, 
and you, the purchaser, are assuming the entire risk as to quality and 
performance. In no event will Emagic be liable for any direct or indirect 
damages resulting from any defect in the software or documentation.

This agreement will terminate if you fail to comply with any term or condi-
tion in this agreement.

This agreement shall be governed by the laws of the Federal Republic of 
Germany.

This manual, copy-protection and software described herein are copy-
righted © 2002 by Emagic Soft- und Hardware GmbH, Halstenbeker Weg 
96, 25462 Rellingen, Germany
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1 Welcome …
… and thank you for your purchase of the Emagic Vintage 
D6—EVD6.

This manual will introduce you to the concept, and function-
ality, of the EVD6. Please read it thoroughly to make the most 
of your new software instrument.

The sound of the Hohner Clavinet D6 is synonymous with 
funk, but was also popularized in the rock, pop and electric jazz 
of the 1970’s, by artists and groups such as: Stevie Wonder, 
Herbie Hancock, Keith Emerson, Foreigner and the Commo-
dores. If you’ve heard “Superstition” or “Higher Ground” by 
Stevie Wonder, then you’ll know that the D6 is the funkiest 
instrument alive!

� Product and manufacturer’s names used in this manual are licensed 
and protected by law. 

The EVD6’s synthesis engine emulates the sound of the 
Hohner D6 Clavinet, and does not make use of any sampling 
technology. It improves on the original in that it can be used in 
stereo, and on a noise level, there’s no comparison. 

The dynamics and scaling of the sounds, over the entire 60-key 
range (F to E) of the original instrument, has been extended 
across the full MIDI range (127 notes).

The EVD6’s engine also simulates the various string buzzes, 
key clicks, and the tone of the pickups found in the original 
instrument. It synthesizes the “pluck” and “bite” of the attack 
phase, as well as the “sticking” of the hammer pads. The sound 
generator reacts smoothly, musically and precisely to the 127 
steps of velocity sensitivity, as defined in the MIDI specifica-
tion. You can almost feel the strings beneath your keyboard!
7
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The extensive set of String parameters allow you to radically 
alter the tone of the EVD6, allowing you simulate an ageing 
Clavinet, or to create new “instruments”. The EVD6 is capable 
of some truly unique sounds, which you’ll discover when 
exploring it, and auditioning some of the included settings.

You’ll appreciate the perfect integration of the EVD6 into 
Logic. In use, it’s much easier to handle than a real world 
Clavinet. There’s no need to transport a bulky and heavy 
instrument, or to attach any cables to it. In addition, the EVD6 
eliminates the problems of reliability, getting new parts, and 
tuning—all of which are becoming increasingly difficult with 
the original instruments.

You will also discover an integrated effects processor incorpo-
rated into the EVD6’s luxurious front panel, which provides a 
number of classic effects popularly-used with the original 
Clavinet. The algorithms featured in the effects processor have 
been adapted, and optimized, for the EVD6. Included are: a 
great sounding Wah, Modulation and Distortion circuit. A sepa-
rate plug-in version of the Wah effect with distortion is also 
included, for use on any audio channel in Logic’s mixer. Logic’s 
extensive selection of native plug-ins are, of course, available 
for use with the EVD6, via the Sends and plug-in Insert slots of 
the Instrument channel strip.

Whatever you play on the EVD6 can be recorded, by simply 
pressing Logic’s record button. Your performances can be freely 
edited in any of Logic’s MIDI editing windows. All EVD6 
parameters and mix automation data, such as volume, 
panorama and effects changes over time, can be recorded and 
edited with Logic’s Track Automation system.

We wish you many years of inspired playing, successful 
arranging, work, fun(k) and productivity with the EVD6!

Your EMAGIC team
8
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2 What the Package Includes
Your EVD6 package contains the following components:

• the Emagic Software CD
• this manual
• a registration card
• a card containing two stickers

Please complete the registration card as soon as possible and 
send it to the Emagic distributor in your country or territory. 
Upon registration you will receive the permanent license code 
for your EVD6.

Once registered, you will have access to …

• a regular update and support service via the Internet:
http://www.emagic.de

• support via our Hotline:
in the USA phone 1-530-477 1050, fax 1-530-477 1052
in Germany phone +49-4101-495-110
in other countries: please consult the Emagic distributor in 
your country or territory.
9
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3 Quick Start

Installation
Although the EVD6 is integrated into Logic’s program code 
(version 5.2 or higher), we recommend that you run the Setup/
Installation procedure by:

• Inserting the EVD6 CD-ROM into your computer’s CD-
ROM/DVD drive.

• This should automatically launch a window on your desktop.
• Double-click on the Installation icon, and follow the 

onscreen instructions. 
• If no window is launched, use your operating system’s file 

management utilities, and browse to the root folder of the 
CD-ROM drive.

The installer will check your Logic version, and will update or 
replace any files needed for the operation of the EVD6.

� It is important that you always run the latest version of your Emagic 
software, as it may contain new features or fixes that affect your 
system’s performance.

EVD6 Authorization
Your new plug-in is integrated into the Logic software. To make 
use of it, an installed copy of Logic Platinum, Gold, Audio 
(formerly Silver) or MicroLogic AV 5 (or higher) is required. 

Rather than installing your new plug-in, you simply need to 
input an alphanumerical code into Logic. This code authorizes 
the EVD6, and writes this information to the XSKey. You will 
find this code on the barcode sticker in the sealed envelope.

� The envelope is sealed. The act of opening the envelope indicates 
your agreement with, and acceptance of, Emagic’s licensing condi-
tions and terms of trade. 
10
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How authorization works:

• Boot Logic
• Open the XSKey Authorization window by selecting   > XSKey 

Authorization. 
• Click once on the “Enter Access Code Here!” field, and type in 

the supplied code.

After entry, your EVD6 will be temporarily authorized: You may 
use it for a period of 12 weeks, with no functional restrictions.

� Please see the Authorization & Registration section, on page 14, for 
information on “unlimited” registration.

The “Instrument” Object Type 
In Logic Audio’s Track-Mixer (or Audio Environment Layer in 
Logic Audio, Gold and Platinum), there is an audio object type 
called an “Instrument”. Instrument channels appear as channel 
strips in the Environment’s Audio layer and Track Mixer 
window. These objects allow software instrument plug-ins to 
be inserted into their Instrument-Insert-slot, as shown in the 
diagram. 

� Note that the use of the insert slot is different to the use of the top 
Insert slot of the Instrument channels in 4.x and earlier 5.x Logic 
versions. This change in operation was introduced in version 5.2, as 
one of several audio engine enhancements, which add to Logic’s 
mixing functionality.

The default song—the song that opens automatically if you 
move your Autoload song out of the Logic folder—features a 
number of pre-configured Instrument channels.

An Instrument channel is an audio object (or an Audio Track in 
MicroLogic AV), with the Cha parameter switched to one of the 
Instruments (the number of Instrument channels varies, depen-
dent on the Logic version in use). Any audio object can be 
switched to operate as an Instrument, by changing this param-
11
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eter (Cha) in the object’s parameter box. You can not insert the 
EVD6 plug-in into an audio object—created by selecting New 
> Audio Object—until its Cha parameter is set to an Instrument 
channel.

To create a new Instrument in MicroLogic AV, simply select 
Track > Create Instrument.

Loading and Playing an EVD6 Instrument
The EVD6 comes with a library of ready-to-play preset sounds, 
known as “Settings”. These Settings can be found in the Logic 
> Plug-in Settings > EVD6 sub-folder, following the installation 
procedure. Please follow these steps in order to audition the 
EVD6 settings:

• Start Logic (or MicroLogic AV), and open the Track Mixer or 
Environment Mixer.

• Select or create a new Instrument object (see above).

• Select the EVD6 from the list of plug-ins, which appears 
after click-holding on the Insert slot of the Instrument 
channel. Note that the menu hierarchy allows you to select 
either a mono or stereo version of the EVD6, from the appro-
priate sub-menu. See the diagram below.

• This will automatically launch the EVD6 plug-in window. 
12
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• Launch the Arrange window, if not already open, via the 
Windows menu, an appropriate Screenset number, or Key 
Command.

• Select the corresponding Instrument channel—i.e. the one 
with the EVD6 inserted—in the Arrange Window’s Track 
List. This enables the object it receive MIDI data from your 
keyboard.

• The EVD6 is now ready to play.

• You may select any of the EVD6 “Settings” (preset sounds/
patches) by click-holding on the flip menu (the downwards 
pointing triangle, to the right of the Bypass button) in the 
silver/gray panel area of the plug-in window.

• Should you close the plug-in window, you can relaunch it by 
opening the Track Mixer or Environment Mixer, and 
double-clicking on the Insert panel of the appropriate Instru-
ment channel.
13
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4 Authorization & Registration

Authorization
The EVD6 is authorized via a convenient software protection 
system known as the XSKey. 

Rather than installing your new plug-in, you simply need to 
input an alphanumerical code into Logic. This code authorizes 
the new plug-in on the XSKey (Expandable System Key). You 
will find this code on the barcode sticker, in the sealed enve-
lope.

� The envelope is sealed. The act of opening the envelope indicates 
your agreement with, and acceptance of, our licensing conditions and 
terms of trade. 

How authorization works:

• Open the XSKey Authorization window by selecting   > 
XSKey Authorization. The window indicates the authoriza-
tion status for all available software instruments, and add-on 
modules. The authorization code for each is stored in the 
XSKey. Please take good care of your XSKey! 
14
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• This window also shows the serial number of your XSKey. 
All codes, for all products, are typed into the Enter Access 
Code Here. field. Click once on the field to enter a code.

• Please type the appropriate code into this field. You will find 
this code on the barcode sticker, in the sealed envelope. 
After entry, your plug-in will be temporarily authorized: You 
may use it for a period of 12 weeks, with no functional 
restrictions.

• If you do not register your new plug-in within this 12 week 
period, it will stop working. 

• So please register now!
• You have two ways of registering—either online or by mail. 

The online registration method is preferable, as it is more 
convenient and faster. Details on both procedures follow.

• After registration, you will receive a further authorization 
code, for unlimited use of the plug-in. This “unlimited use” 
authorization code must also be entered in the XSKey Autho-
rization window. Thereafter, you will have unlimited use of 
your plug-in.

Registering Online
If you have Internet access, please register the plug-in online. 
This is the simplest and fastest method. Keep the envelope 
with the barcode sticker (and the serial number of your XSKey) 
handy. You can find the XSKey serial number on the barcode 
stickers that came with your Logic 5 version, and under   > 
XSKey Authorization. 

Start your web browser and navigate to:

www.emagic.de/registration

• Input the requested data. 
• A successful online registration will be indicated via e-mail 

immediately. 
• After a short processing period, you will receive your autho-

rization code for unlimited use via e-mail.
15
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Registering by Mail
If you don’t have Internet access, you may register by mail. To 
do so, please fill out the registration card attached to/enclosed 
in the envelope.

• Please fill out the card completely. 
• Attach one of the XSKey serial number stickers (as supplied 

with your Logic 5 package) onto the appropriate panel.
• Detach the Plug-in Registration Card from the envelope. 

Send this card back to the Emagic distributor in your country 
or territory, using the supplied return envelope.

• Please allow a period of 10 to 14 working days for the 
processing of your card. You will receive the authorization 
code for unlimited use by mail. The online registration 
method is preferable, and more convenient.

This “unlimited use” authorization code must also be entered 
in the XSKey Authorization window. Thereafter, you will have 
unlimited use of your plug-in. 

XS Key Status Messages
The following describes the messages you may see in the 
XSKey Authorization window.

authorized: 
The module is purchased, it is registered with Emagic, and the 
code for permanent authorization has been entered. The 
module is ready for “unlimited” use.

(Demo) expiring in … days: 
This module is fully functional for the specified number of 
days. Purchase, and registration with Emagic, will provide you 
with a code to permanently authorize the module. If no code is 
supplied within the time period, the module will stop working 
after the specified number of days has elapsed.
16
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� It is recommended that you do not attempt to change the date of the 
system clock during a limited authorization period, as this may reduce 
the time before the module stops working.

activate Demo …:
The module is not active, but it is possible to enable its demo 
mode. To do so, click once in the desired “Activate Demo…” 
field. Please note that following its initial launch, the demo 
mode for the module can not be stopped, and will continue to 
count down! If a permanent license/authorization code is not 
purchased within the demo period, use of the module will 
expire.

(Demo) expired:
The limited authorization period is over. It is not possible to 
use the module until a valid license code is entered.

empty field:
The module is not active, and no demo mode is available. The 
only way to activate such modules is by entering a license code.

Optimization Programs
The EVD6’s copy protection (the XSKey) is not affected by 
disk optimization and defragmenting programs. You may use 
programs such as Norton Speed Disk, MS Defragmenter or 
DiskExpressII as often as you like.

Formatting the Hard Disk
Hard disk formatting or partitioning does not affect the EVD6/
XSKey.
17
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5 The EVD6—Concept and 
Functions

Overview and Integration
Dependent on the version of Logic installed on your system, up 
to 64 instances of the EVD6 (and other software instruments) 
can be inserted into the various Instrument channels. Each 
instance of the EVD6 offers up to 24 voices. It should be noted, 
however, that the total polyphony of the EVD6 is always CPU-
dependent.

The output signal of the EVD6 is fed into the input of the 
Instrument channel strip, where it can be processed via 
inserted plug-ins and/or sent to busses. Given a fast enough 
computer, you could conceivably arrange and mix an entire 
song using several software-based Instruments, such as: 
Emagic’s ES1, ES2, EXS24, EVP88, EVB3 and the EVD6, of 
course. This has the added benefit of superior sound quality 
and timing, as the signal never leaves the digital domain. And 
each single mixer, effect plug-in and software instrument 
setting is saved and later recalled with the song.

The Bnce (Bounce) button found to the bottom right of Master 
audio object(s) allows you to write submixes of EVD6 tracks—
as one or more audio files—to disk at any time. Such bounced 
Instrument track audio files can then be used and handled like 
any other audio region in the Arrange window. You can make 
use of this facility to free up CPU resources when a song 
requires more processing power than your CPU is capable of 
delivering, i.e. the CPU does not allow all desired EVD6, and/
or other Instrument tracks to be played in realtime.

All parameters of the EVD6 and all associated Instrument 
channel parameters—Volume, Pan etc.—can be fully auto-
mated. Automation data can be easily recorded, created and 
edited with Logic’s Track Automation system.
18
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The Plug-in Window
Hands-on operation of the EVD6 is performed in the plug-in 
window. The plug-in window can be accessed by simply 
inserting the EVD6 into the Instrument Insert slot of an Instru-
ment channel. 

� This is a preference and can be deactivated: Audio > Audio 
Preferences… > (Display) Open plug-in window on insertion.

If closed, double-clicking on the blue EVD6 label (on the 
Insert slot of an Instrument channel) will open the plug-in 
window. When launched, the plug-in window allows access to 
all EVD6 parameters. Every instance of the EVD6 has its own 
plug-in window, allowing discrete settings for each.

The plug-in window of the EVD6.

Automation
As with every Logic plug-in, the EVD6 can be fully automated.

• Simply select the desired EVD6 track, in the Arrange 
window.

• Select View > Track Automation, if not already active.
• Set the Instrument channel to Write, Touch or Latch mode—

either in one of the Mixer windows, or directly on the 
Arrange window track.
19
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• Press the Play button, or start playback by Key Command.
• Move the faders, knobs and switches in the EVD6’s plug-in 

window. 
• Press the Stop button, or use the Key Command, when 

done.

The generated data will be recorded as track Automation and 
displayed as curves in the Instrument track in the Arrange 
window. This way the EVD6’s faders, knobs and switches will 
be automated on playback. You can record automation data, in 
one or more takes, for each parameter, as described.

It is also possible to record, or create, region- or sequence-based 
parameter automation using HyperDraw, as with earlier 
versions of Logic. 

All types of automation data can be freely edited or created in 
the Arrange window, or other suitable Logic editor. A descrip-
tion of all automation editing facilities can be found in the 
Logic 5.x Addendum/Reference manual, and Online Help 
system.
20
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6 Selecting and Saving Sounds
Parameter adjustments using the controls in the EVD6 plug-in 
window can be saved as a Setting. The Setting flip menu is 
reached by clicking the downwards pointing arrow allowing the 
selection and loading of an EVD6 Sound—i.e. a Setting.

A Setting can be saved with Save Setting or Save Setting as… 
and re-called with Load Setting.

A setting must reside in the appropriate sub-folder—Logic > 
Plug-in Settings > EVD6—for it to appear in the Setting menu. It 
is also possible to further categorize your EVD6 settings by 
creating additional sub-folders within this directory. The folder 
structure is reflected by the hierarchical menu structure in 
Logic. 

The Setting flip menu options
You can step through existing settings in the menu with 
Previous and Next Setting.

It is also possible to copy and paste parameter settings from one 
EVD6 instance to another using the Copy and Past Settings 
commands. Open the EVD6 instance of which you like to copy 
the sound setting and select Copy Setting. Now open the 
EVD6 instance into which you like to paste the setting and 
select Paste Setting. 

To save your personalized sound settings, select Save Setting 
or Save Setting as…, and give the sound an appropriate name 
in the ensuing Save dialog box.
21
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7 The Parameters of the EVD6
The parameters described in this section are easier to manipu-
late from within the Editor view of the plug-in window. If you 
can see multiple horizontal sliders on a blue background, please 
switch from the Controls view to the Editor view, using the flip 
menu found to the right of the silver/gray portion of the plug-in 
window.

You can reset many of the EVD6’s parameters to zero, or a 
“default” value, by clicking once on the parameter control, 
while holding O.

� Most of the “slider” parameters on the EVD6 interface are mapped 
to zero-centered ranges—i.e. if a slider is in its middle “neutral” posi-
tion, it doesn’t affect the base sound of the selected EVD6-model. If 
the slider is moved to the left or right, it will scale the original param-
eter value positively or negatively by that amount.

The EVD6 front panel can be broken down into five main 
sections, namely: the Global silver panel section at the bottom, 
the Excite/Click and String parameters, to the top left, the 
Pickup window in the top center, and the Effects section, found 
at the top right.

Global Parameters
The Global Parameters are found in the lower-left portion of 
the EVD6 Graphical User Interface (GUI). 

Voices
The voices parameter allows you to set the maximum number 
of voices that can sound simultaneously. Lowering the value of 
this parameter limits the polyphony and also the processing 
requirements of the EVD6. When the parameter is set to 1, the 
22
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instrument is monophonic, and uses minimal CPU power. The 
maximum setting is 24, allowing for sustained glissandi. A 
setting of 24 will, of course, be more processor-intensive. 10 is 
the default. Click-hold, and use your mouse as a slider to adjust.

Tune
The global Tune setting works in Cent steps. A value of 0 equals 
concert-pitch A440 Hz. The range is ±50 Cents or, in more 
“musical” terms, plus/minus half a semitone. For transpositions 
in semitone or octave steps, please use the instrument param-
eter box in the arrange window, as per any standard MIDI 
instrument. Click-hold, and use your mouse as a slider to 
adjust.

Bender
This parameter determines the bend range, in semitone steps. 
Click-hold, and use your mouse as a slider to adjust.

Warmth
Amount of random deviation from an equal-tempered scale. 
High values add “life” to sounds. It can be useful for simulating 
an instrument which has not been tuned for a while, or for 
slightly “thickening” a sound. When playing chords, the 
Warmth parameter is especially noticeable creating the warm 
detuning or beating effect among the chord notes. Click-hold, 
and use your mouse as a slider to adjust.

Stretch
The EVD6 is tuned to an equal-tempered scale. As a deviation 
from this standard tuning, you can stretch the tuning in the bass 
and treble ends of the sound. This simulates the way stringed 
keyboard instruments such as pianos are tuned, attempting to 
find a more consonant tuning balance between high and low 
notes. The stretch feature was included for situations where 
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you may wish to use the EVD6 alongside acoustic pianos. 
When arranged in conjunction with an orchestra or synthe-
sizers, the stretch tuning facility should not be used. Click-hold, 
and use your mouse as a slider to adjust.

� The tones of clavinets, harpsichords and pianos have “inharmonici-
ties” in their harmonic structure. The frequencies of these “over-
tones” (harmonics) are not exactly “whole-number” multiples of the 
base frequency, as pythagorean theory dictates. They are only approx-
imate and are, in fact, a little higher. The overtones of lower (tuned) 
notes, therefore, are more closely related to the main frequencies of 
the upper notes. Also see the Stiffness / Inharmonicity section, on 
page 33.

� When applying Warmth and Stretch, you should consider that these 
parameters may result in a detuned sound, which is similar to the 
overuse of a chorus effect.

Pressure
On the original D6, applying pressure (aftertouch) to a 
depressed key raises the pitch slightly. The Pressure parameter 
allows you to do this, or alternately lower the pitch by pressure. 
Click-hold, and use your mouse as a slider to adjust. Range 
−1.00 to +1.00

Filter Switches
The four filter switches (also known as “color” or “tone” 
switches) emulate the original switches on the D6, with one 
exception. When all switches are set to “off”, you’ll hear the 
unfiltered sound, rather than the original D6’s “humming 
silence”. Simply click anywhere on each switch to toggle 
between its on/off position. Active switches are indicated by 
pale green lettering, and by being depressed towards the 
bottom of the plug-in window. You may use the filter switches 
in any combination of on/off positions.

• Brilliant—makes the sound “nasal/cuts bass”.
• Treble—makes the sound “sharper/cuts bass more gently”.
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• Medium—makes the sound “thinner/slight bass reduction”.
• Soft—makes the sound “softer/more muted”.

Pickup Switches
As with the original D6, the two pickups can be used in 
different modes. The switches “AB” and “CD” are used to 
change modes. According to the different switch positions the 
internal wiring of the two pickups is changed and with it the 
sound at the combined pickup output. The EVD6 features an 
additional menu displaying the current pickup mode above the 
pickup switches. More information on the use of these param-
eters/the pickups is found in the Pickup Parameters section, on 
page 33.

Stereo Spread
Pickup—While the original D6 only has a mono output, the 
EVD6 has stereo capabilities. When both pickups are active 
(upper+lower and upper-lower modes), the two pickup signals 
can be spread across the stereo spectrum. To adjust the position 
of the stereo spread, click-hold on the up/down arrows in the 
lower half of the circular button—i.e. in the Pickup section.

Turning the Pickup Spread control up will move the signals of 
both pickups away from the center position—one to the right, 
and the other to the left. Extreme left/right positions are 
reached when Spread is set to its maximum value. Range: 0.00 
(center, no effect) to 1.00 (full left/right stereo).

More information on the use of the pickups is found in the 
Pickup Parameters section, on page 33.

C/D Switch A/B Switch What It Does

down down “neck” pickup—warm sound

down up “bridge” pickup—bright sound

up up both pickups—full sound

up down both pickups out of phase—thin sound
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Key—This parameter allows a keyscale modulation of the 
panning position—i.e. panning is determined by keyboard 
position. The center position is MIDI note 60 (Yamaha C3). To 
adjust the Key(board) position, click-hold on the up/down 
arrows in the top half of the circular button—i.e. in the Key 
section. 

When fully turned up, the extreme left/right position will be 
reached at MIDI note 60 +/- 30 semitones. Range: (center, no 
effect) to 1.00 (full left/right stereo).

� You can use both spread types at the same time. They will automati-
cally be mixed.

� The effect of both stereo spread parameters is reflected graphically in 
the area around the circular stereo spread button.

Model
The Model parameter allows you to select a basic type of tone, 
or “model”. Each model has its own unique tonal characteristic, 
and each is suitable for the creation of very different sounds. 
Each model is an instrument in its own right, and can immedi-
ately be played, without any further editing. We will discuss 
each model below, and encourage you to experiment with each.

To select a model, simply click-hold in the area between the 
Stereo Spread and Level controls, and make your choice from 
the pop-up list. Release the mouse button once your selection 
is made. All EVD6 parameters are then available to further 
shape the tonal character of the model.

In some respects, the Model parameter can be viewed much 
like making an oscillator waveform selection in a synthesizer. 
As with raw synthesizer waveforms, the editing parameters can 
affect the model quite differently. As an example, particular 
Excite settings may make one model more “nasal’ sounding, 
and another model more “noisy”. These behavioral differences 
are a result of the unique harmonic structures used by each 
model.
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The Models

Class(ic) D6 
An almost 1:1 emulation of the original D6. It includes string 
noises on long decays, and realistic release behavior, following 
the release of the key(s). Each D6 was unique in its way, so feel 
free to adjust the many sound shaping controls, in order to 
match the sound of D6 units that you have used, or heard.

Old D6
This model emulates a well-worn D6. Hammers and strings are 
a bit aged, and worn. The sound of the sticky hammer heads is 
emulated, as well as the typically “richer” sound in the bass 
range.

Sharp D6
Very sharp with a lot of bite—nice with wah wah and phaser.

Mello(w) D6
As the name suggests, a mellow fellow.

Basic
Basic, simple clavinet

Domin(ation)
A powerful model with a strong and punchy attack—reacts 
more aggressively to velocity than other models.

GuruFnk (Funk)
In the lower bass-octave ranges, the string oscillations become 
increasingly resonant over time, until they finally collapse (after 
20 to 30 seconds). Higher notes have a much shorter decay, 
which also applies to their resonating behavior. This model 
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invites heavy, funk-style bass playing in the lower octaves. It’s 
nice with a little phaser, and sustained chords, when playing 
low bass notes. Adding a Logic Delay plug-in is also a great 
option!

Harpsi(chord)
Harpsichord-like model.

Pluck
Plucked string—changing the pick-up positions allows further 
modifications, making the sound more guitar-like. “Harp” style 
sounds are also possible, by positioning the lower pick-up 
around the mid position. To get a harp sound increase String 
Decay, Release and Excite Shape and decrease Excite Brilliance.

(Tuned) Wood
Somewhat wooden, thin and with some inharmonic overtones. 
Can sound slightly detuned in some contexts. 

Ltl (Little) India
Sitar-like sound, rich in resonance.

S(tring) Bells
A bell model with strong inharmonic overtones (inharmonici-
ties).

Special Notes about the Models
You may note some “zones” on the keyboard where the sound 
changes significantly between adjacent keys. This is inten-
tional, and reflects the behavior of some of the real clavinet 
models emulated by the EVD6. The original D6 has some 
strong key-to-key timbral differences, with the most obvious 
one being between the highest, wound string, and the lowest, 
non-wound string. 
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If you’re a player who likes the original’s sound, but not the 
original’s mechanical timbre jumps, the EVD6 offers a 
smoothed model—MelloD6.

When using a setting with both pickups quite close to the 
upper end of the strings and Brilliant + Treble filter switches 
active, the fundamental tone is quite weak in the output signal. 
As such, you will mostly hear the overtones that are not exactly 
in tune for inharmonic models (e.g. “Wood”). Try moving the 
pickups to the center, and deactivate all filter switches to 
circumvent this “detuned” effect.

Level
Sets the (post -Effects) level, in dB (decibels). Click-hold, and 
drag, to adjust. If the MIDI controller used for “Expression” is 
not assigned to Wah or Damper, it is used to scale the output 
level.

Damper Wheel and Damper Ctrl
The original D6 features a damper slider on the right-hand side 
of the keyboard that allows the player to create muted string 
sounds. Click-hold, and drag, or make use of a MIDI controller, 
such as your keyboard’s mod wheel, to adjust the Damper 
Wheel. The Damper Wheel position is saved with the sound.

The Damper Ctrl (number) parameter allows you to select the 
MIDI controller that moves the Damper Wheel. Click-hold, and 
make a controller number/name selection from the flip menu. 
Release the mouse button, once your selection is made. 

The software-wheel is moved on-screen, when controlled via 
MIDI. MIDI control can be disabled by selecting the off 
option, found in the flip menu.

� The parameter Wah Ctrl is discussed on page 37.
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Velocity Curve
There are nine preset velocity curves available for the EVD6. 
These allow you to set up a curve which is suitable for your 
playing style, or the sound. 

The nine curves available are: fix25%, fix50%, fix75%, 
fix100%, convex1, convex2, linear (the default), concave1 and 
concave2.

Excite Parameters
Excite describes the string excitation, the physical power 
which stimulates the string to oscillate.

Shape
Shape adjusts the attack shape, allowing you to simulate the 
“hardness” of the rubber hammers in the original D6. As the 
instrument aged, the hammers would become worn, split etc., 
which had an impact on the overall brightness/tone of the D6. 
Negative values (to the left) provide a softer attack, while posi-
tive values result in a harder attack. Range: −1.00 to +1.00

Brilliance
Controls the harmonic content of string excitation. Positive 
values (to the right) result in a sharper sound. Negative values 
result in a more muted sound. Range: −1.00 to +1.00

Click Parameters
The rubber hammers of the original D6 age and decay, just like 
piano hammer felts. Well-loved (i.e. worn out) D6’s produce a 
distinctive “click” when a key is released. This is due to the 
string sticking to the rubber hammer, before being released. 
The characteristics of this release click are part of each model, 
and can be finely adjusted with the following parameters.
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Intensity
Positive values increase the level of the release click above the 
original model setting. Negative values reduce the level—e.g. a 
value of −1.00 equals no release click. If you’d like to simulate 
an old D6, increase the value, by moving the slider to the right. 
Range: −1.00 to +1.00

Random
Controls the amount of random click level variations across the 
keyboard. This slider simulates the wearing of some hammers, 
but not all of them, emulating the real-world wear and tear of 
the original. The further to the right the slider is moved, the 
greater the variation between key clicks on some keys. If all the 
way to the left, all keys have the same level of key click. Range: 
0.00 to +1.00

Velocity
The Velocity parameter controls the level of release click modu-
lation by velocity—i.e.: Note On velocity or Note Off/release 
velocity. Range: 0.00 to 1.00. The selection of note on/off infor-
mation as the modulation source is determined by the …

KeyOff / KeyOn Buttons
Press the appropriate button to select the type of velocity infor-
mation that should be used for release click level modulation, 
i.e. press the KeyOn button, if you wish to use your attack 
velocity (how hard you hit the keyboard) as the value for the 
key click. If you wish to use your release velocity (how quickly 
you release the keys on your keyboard) to determine the value 
of the key click, press the KeyOff button. This requires a 
keyboard with release velocity facilities.

Needless to say, the Velocity parameter must be set to a reason-
able level in order for the KeyOn/KeyOff modulation to be effec-
tive.
31
User Manual
Version 1



The Parameters of the EVD6
String Parameters
The behavior of the strings is basically determined by the 
Model, but the following parameters allow you to modify 
several string characteristics, relative to the model setting. See 
the Model section, on page 26, for further information on model 
selection.

Decay
Positive values provide a longer Decay time after attacking a 
note. Negative values reduce the decay time. Range: −1.00 to 
+1.00

Release
As per the Decay parameter, but for the Release time (following 
the physical release of a key). Range: −1.00 to +1.00

Damping
The Damping parameter allows you to modify the “damping” 
of strings. Damping is essentially a faster decay for the higher 
partials/harmonics in a sound, and is a property of the string 
material used (high damping for catgut strings, medium 
damping for nylon strings, low damping for steel strings). Soni-
cally, damping results in a more mellow and rounded, or 
“woody” sound, dependent on the Model in use. A positive 
value will make the sound more mellow, and a negative value 
will allow more of the higher partials through, making the 
sound brighter. Range: −1.00 to +1.00

Tension Mod
Tension modulation is a non-linear effect on strings, which 
usually results in the pitch being slightly higher, immediately 
after being plucked/struck/strummed. It is common to all 
stringed instruments, like the D6, guitars etc. This string char-
acteristic is built into each model, but can be further modified 
with the Tension Mod parameter. The range of this parameter is 
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quite large, and can be used to get weird sound effects out of 
the EVD6. It can also be used to simulate an out-of-tune 
Clavinet, or as a quick and dirty sitar sound, for those “Norwe-
gian Wood” covers. Range: −1.00 to +1.00

Stiffness / Inharmonicity
These two parameters allow you to intensify/reduce the 
strength of inharmonicity in the sound. When combined at 
different levels, these parameters can create “metallic”, bell-
like sounds, or DX-like electric piano style sounds. They can 
also be useful for wood bass sounds. Experiment with both 
parameters, on each Model.

The higher the level of the Inharmonicity parameter, the lower 
its threshold to incoming frequencies. In other words, the 
Inharmonicity parameter determines the lowest harmonic, 
above which inharmonic spectral spreading becomes relevant. 
Range: −1.00 to +1.00

Stiffness controls the intensity of this stretching/spectral 
spreading. Range: −1.00 to +1.00

The keynote is not affected by these parameters.

Pitch Fall
Due to the physical construction of the original D6, the pitch of 
each note falls immediately after releasing the key. The inten-
sity of this effect, which varies with each model, can be modi-
fied with this parameter. To completely deactivate the pitch 
fall, regardless of the selected model, set this parameter to the 
leftmost position (value −1.00). Range: −1.00 to +1.00

Pickup Parameters
The original D6 is equipped with two electromagnetic pickups, 
much like those found in electric guitars: one below the strings 
(“lower”) and one above (“upper”).
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Pickup Position
In contrast to the fixed pickups of the original instrument, the 
EVD6 pickups can be set to arbitrary positions and angles. To 
do so, simply click-hold on one end of the desired pickup 
(Upper or Lower) and drag the end to another position. Release 
the mouse button when done. Both values can be moved simul-
taneously. To do so click and drag the point in the middle of the 
pickup to a new position.

The numerical upper and lower panels, to the top-left of the 
window, indicate the current position of each pickup—with 
respect to the string. A value of 50 (percent) means that the 
specific pickup end is positioned above/below the centre of the 
string, resulting in a full-bodied tone. When the pickup 
approaches either end of the string (values near 0 or 99), the 
tone becomes thinner. 

� In the graphical pickup window the strings are aligned from left to 
right in respect to pitch—low strings to the left, high strings to the 
right. 

� It is recommended that you repeatedly strike a note when moving 
pickup positions, in order to hear the effect that the pickup position 
has on the overall tone of your sound. 

� Interesting, phaser-like effects can be achieved by automating the 
pickup positions.

� Important!
It is possible to cross-over the pickups in the Pickup Position window. 
This may lead to a “hole” (non- or very soft sounding notes) within 
your keyboard range. This is due to a phase-cancellation between the 
pickups. If you encounter such “cancellations”, adjust one (or both) 
of the pickups until the required notes are playable.
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Pickup Mode
Pressing the AB and CD switches will change the virtual wiring 
of the two pickups. The current wiring, the EVD6 calls it 
Pickup Mode, is displayed in the Pickup Mode panel. You can 
also click directly on the Pickup Mode panel, and select the 
desired mode from a flip menu.

• C + A = Lower
• C + B = Upper
• D + A = Lower—Upper
• D + B = Lower + Upper

Also see the Stereo Spread section, on page 25, and the Pickup 
Switches section, on page 25.

Effects Parameters
No Clavinet simulation would be complete if it didn’t include a 
selection of effects processors. The EVD6 doesn’t disappoint 
in this regard, incorporating three “footpedal” effects that have 
formed an integral part of “classic” Clavinet sounds over the 
decades. Each effect was painstakingly modelled on effects 
pedals that were available in the heyday of the Clavinet—the 
1970’s—ensuring that “vintage” sound in your performances.

Needless to say, you can also take advantage of Logic’s exten-
sive range of effect plug-ins, to further tailor your sound.

Distortion
The integrated distortion effect can be adjusted in terms of 
intensity and tone. Range: Tone −2000Hz to 20000Hz, Gain 
−0dB to 20dB. Using low Tone and Gain settings the distortion 
unit allows the creation of warm overdrive effects. Bright and 
screaming distortion effects are produced with high Tone and 
Gain settings.
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Compressor
Please note that the Distortion effect is always preceded by a 
compression circuit (shown in the panel above the Tone knob—
with a ratio of 1:19.5) This allows you to increase/decrease the 
perceived gain, to provide the desired input level to the Distor-
tion circuit.

The compressor allows for really “crunchy” distortions, 
coupled with wah, or phaser. It can also be useful for enhancing 
the keyclick sound, and emphasizing harmonics in the various 
models.

Compression Ratio
The Compression Ratio panel allows you to adjust the slope of 
the compression applied. To adjust, simply click-hold on the 
panel, and use the mouse as a slider. 

The Compressor is “tied” to the Distortion effect, and always 
precedes it. As such, the Effects Order parameter is very impor-
tant for placement of this compressor in the effects chain. 
Please see the FX Order section, on page 39, for further infor-
mation.

� If the Compressor/Distortion is used as the last effect in the chain, and 
its gain is turned down, but the Compression Ratio is high, you will 
effectively compress the output signal of the EVD6. 

Wah
The typical Wah effect is generated by a dynamically moving 
filter. The EVD6 offers simulations of several classic wah 
effects, as well as some basic filter types. Possible values are: 
off, ResoLP, ResoHP, Peak, CryB, Morl1, Morl2. The abbrevia-
tions are for Resonant Low and High Pass filters, Peaking filter, 
CryBaby, Morley 1 and Morley 2. The latter three are famous 
effects pedal models that continue to be manufactured.

� The combination of wah, followed by distortion, delivers those 
sought-after funky fuzz-wah results.
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Wah Mode
Simply click-hold on the (Wah) Mode panel, and select the 
desired (pedal effect) model from the pop-up menu.

Range
How far up or down in frequency the cutoff of the filter (set 
with Wah Mode) is able to move depends on the Range setting. 
With Range set to the left the cutoff will move in a narrow range 
only. To provide a wider control range, turn the Range param-
eter to the right.

Envelope (Depth)
An auto wah effect is produced by using an envelope follower 
to control the filter cutoff automatically. The envelope shape 
follows the dynamics of your performance. The sensitivity of 
the envelope in respect to your performance and thus the 
resulting filter modulation depth is set with the Envelope 
parameter. Turn Envelope to the right to increase the modula-
tion depth.

Wah Ctrl
The Wah Ctrl parameter allows you to define the MIDI 
Controller (number/name) that is to be used as the manual wah 
effect control—a MIDI foot controller for example. MIDI-
control/coupling can be disabled by selecting off.

� Both, envelope and manual controller can control the wah simulta-
neously. In this case the effect of envelope and manual controls are 
mixed.

Wah Pedal Position (Controls View only)
Activate the “001011” switch (to the left of Bypass) to slide out 
the blue control view panel.
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As with the Damper, there is a slider named Wah Pedal Position 
that always represents the current pedal position. This ensures 
that the most recent (i.e. last) pedal position is saved with the 
sound. It also ensures that it can be automated by either 
recording the MIDI controller messages, or by using the new 
Track Automation system.

Modulation
The EVD6 features a Modulation unit with three switchable 
modulation effect types.

Mode
The Mode panel allows you to select either a Phaser, Flanger or 
Chorus as the modulation effect. Click-hold, and make your 
choice from the pop-up menu.

Phaser
The Rate parameter adjusts the speed of phasing, and the 
Intensity parameter adjusts the depth of phasing. Ranges: Rate 
−0.10Hz to 10Hz, Intensity −0 to 100

� High values lead to very deep, self-oscillating phase shifts, for those 
“cutting” (and ear and speaker damaging, so take care!) sounds. 

Chorus
The Rate parameter adjusts the speed of the Chorus effect, and 
the Intensity parameter adjusts its depth. High Intensity values 
lead to ensemble-type effects. Ranges: Rate −0.10Hz to 10Hz, 
Intensity −0 to 100

The EVD6 chorus provides a warm and gentle chorus effect.

Flanger
The Rate parameter adjusts the speed of flanging, and the 
Intensity parameter adjusts the depth of flanging. Ranges: Rate 
−0.10Hz to 10Hz, Intensity −0 to 100.
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FX Order
The order of the serial effects combination can be selected 
here. The four choices are:

• WDM—Wah > Distortion > Modulation
• DWM—Distortion > Wah > Modulation
• MDW—Modulation > Distortion > Wah
• WMD—Wah > Modulation > Distortion

Just like the foot pedals which could be freely connected to 
each other in series, the EVD6 effect section invites you to 
experiment.

The freely assignable effect routing is especially useful for 
selecting whether a distorted signal shall be wah-filtered, or if 
the wah-filtered sound shall be distorted (for screaming 
sounds), as one example. 

External Wah Plug-in

As a special bonus for all EVD6 owners, we have included a 
standalone plug-in version of the Wah effect, which can be used 
as an Insert or Bus effect, anywhere in Logic’s Mixer.

To launch it, open Logic’s mixer, click on the desired insert slot 
of the channel, and select (Mono/Mono->Stereo) > Logic > 
Filter > Fuzz-Wah.
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This external Wah plug-in incorporates an additional 
compressor and fuzz/distortion facilities, and features some 
additional parameters over the integrated EVD6 Wah. These 
are outlined below.

FX Order

This parameter allows to you select the order in which the 
Fuzz/Wah effects are placed. Choices are: Fuzz- >Wah or Wah-
>Fuzz.

Wah Mode (same as EVD6)
There are simulations of several classic wah effects, as well as 
some basic filter types available. Available models: off, ResoLP, 
ResoHP, Peak, CryB, Morl1, Morl2.

Wah Level
Can be used to adjust the level of the wah-filtered signal, rela-
tive to the original level. Also see the AutoGain section below.

AutoGain
While sweeping through the main formants of the input signal, 
the output level of the wah may vary wildly, which is not always 
desirable. Activating the AutoGain parameter will automatically 
compensate for this side-effect. Range: on/off

To hear the difference AutoGain can make: 

• Switch it to on.
• Raise the effect level to a value just below the mixer’s clip-

ping limit. 
• Make a sweep with a high relative Q setting.
• Now switch AutoGain to off, and repeat the sweep.

� Please take care while doing this, or your ears and speaker system 
may be damaged (or the dog will bite you!).
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relative Q
The quality of the main filter peak can be increased/decreased, 
relative to the model setting, thereby obtaining a sharper/softer 
wah sweep. When set to a value of 0, the original setting of the 
model is active. Range: −1.00 to +1.00 (0.00 is the default)

Pedal Range
Common MIDI foot pedals have a much larger mechanical 
range than most classic wah pedals. 

The exact sweep range of the wah filter effected by the MIDI 
foot pedal is set with the Pedal-Range parameters. The highest 
and lowest possible value reached by the pedal is graphically 
represented by a gray bracket around the Pedal Position fader 
(see below). The left and right limit is set by clicking and 
moving it with the mouse. Additionally both values can be 
moved simultaneously by clicking in the center of the bracket 
and moving it to the left or right.

Pedal Position
This parameter represents the current position of the wah 
pedal. 

To control and automate the Pedal Position via an external 
MIDI controller e.g. a MIDI pedal, your Logic environment 
has to be prepared accordingly. For more information please 
read the Controlling the EVD6 via MIDI section, on page 43.

AutoWah Depth (same as EVD6)
In addition to using MIDI foot pedals (see above), the wah 
effect can be controlled using the auto wah facility. The sensi-
tivity of the auto wah can be set with the Depth parameter. 
Range: 0.00 to 100. (See also the Envelope (Depth) section, on 
page 37.)
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AutoWah Attack / Release
These parameters allow you to define how much time it takes 
for the wah filter to open and close. Range (in milliseconds): 10 
to 10,000

(Fuzz) Comp Ratio
See also the paragraph Distortion on page 35

The ratio of the integrated compressor can be adjusted 
between 1:1 (no compression) and 30:1. The Compressor is 
“tied” to the Fuzz/Distortion effect, and always precedes it. As 
such, the FX Order parameter is very important for placement of 
the compressor in the effects chain.

Fuzz Gain 
Controls the level of Fuzz (distortion). Range: 0dB to 20dB.

Fuzz Tone
The integrated fuzz/distortion effect can be adjusted, tonally, 
with this parameter. The combination of wah, followed by fuzz/
distortion, produces those funky fuzz-wah results. Range: 
2,000Hz to 20,000Hz
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8 Tips, Tricks and Info

Controlling the EVD6 via MIDI
It is possible to control and automate the parameters of the 
EVD6 and other plug-ins using the MIDI controls provided by 
many master keyboards or MIDI fader boxes. 

As discussed in this manual, MIDI control for the EVD6 
Damper and Wah Filter Cutoff is easily set up using the pop-up 
menus next to the damper wheel on the EVD6 surface. See 
also page 29 and page 37.

To control other parameters of the EVD6 or the Wah plug-in 
via MIDI the Logic environment needs to be modified accord-
ingly. 

Below you will find an example on how to control the Pedal 
Position of the Wah plug-in using the modulation wheel (CC#1) 
of your MIDI keyboard. The example requires some environ-
ment programming skills. Additional information on environ-
ment programming can be found in your Logic reference 
manual.

This is a basic environment patching example to control and automate 
the parameters of the Wah plug-in via MIDI.
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A transformer object has been inserted into the MIDI data 
path. In this case the transformer object is set up to transform 
incoming MIDI events into the proprietary “fader” event type 
used by the automation system. The top output cable of the 
transformer object is connected to the audio object providing 
parameter and automation control. The lower output cable of 
the transformer object is connected to the sequencer input 
maintaining the regular MIDI data path in Logic.

Double click the transformer object to open the transformer 
parameter box. With the flip menu select Track Automation 
Splitter as your transformer mode. In this example the trans-
former is set up to except MIDI modulation data (CC#1) on any 
MIDI channel and to transform this data into fader (#2) events 
controlling Pedal Position. The first field after “fader” repre-
sents the slot number of the plug-in. In our example this is slot 
number #2 (number #1 is the channel itself). The second field 
represents the “fader” parameter number. The parameter 
Pedal Position has the number #2. 

� The quickest way to determine the “fader” number of a parameter is 
to connect a monitor object to the environment output of the corre-
sponding audio object and then move the control of the parameter in 
question. The monitor will display the requested data type informa-
tion.
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Using the setup discussed above it is possible to control the 
Pedal Position of the Wah plug-in via a MIDI modulation 
wheel. Any movements can be automated by way of Logic’s 
automation modes: read, write, touch and latch.

� There is still the possibility of controlling the EVD6 parameters via 
MIDI as it was done in Logic prior to version 5. Prior to Logic 5 Contin-
uous Controller #65 and up are used to control plug-in parameters. 
The following preference has to be set: Options > Song Settings > 
MIDI Options… > Software instruments use MIDI Controller 
65-127.

Double-Triggered Notes
When experimenting with the EVD6, or auditioning some of 
the included Settings, you may encounter sounds which seem 
to be triggered on both the note on and the note off.

This is actually a feature, which emulates the original D6. The 
real D6 has the “problem” of the strings sticking to the 
hammers if they are worn out, producing a second trigger when 
the key is released. You can adjust the intensity of this “key-off 
click”, with the Intensity slider in the “Click” section (see the 
Click Parameters section, on page 30). Move the slider to the left, 
and the second key off trigger will no longer be audible!
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9 A Brief History of the Clavinet
German Company, Hohner, was the manufacturer of the 
Clavinet. Hohner were known mainly for their reed instru-
ments (harmonicas, accordeons, melodicas etc.), but had made 
several “classic” keyboards, prior to the first incarnation of the 
Clavinet, known as the “Cembalet”.

Musician and inventor, Ernst Zacharias, designed the 
Cembalet in the 1950’s. This was intended to be a portable, 
amplifiable version of the Cembalo, or Harpsichord. It’s mech-
anism worked by plucking the end of a flat reed with the key, 
which was then picked up and amplified in much the same way 
as an electric guitar. 

A year or two after the Cembalet’s release, two “Pianet” models 
appeared. Both the “CH” and “N” models used flat reeds for 
tone generation, but employed a very different plucking/
striking action. When a key was depressed, it engaged a “sticky 
pad” with a foam backing, which actually stuck to the reed. 
When the key was released, the weight of the key caused the 
pad adhesive to free itself from the reed. This made the reed 
vibrate, and this vibration was then amplified. 

The model “T” Pianet was released several years later, and 
utilized a soft rubber “suction pad” on the reeds, rather than 
the adhesive of the “CH” and “N” models. This method still 
had several drawbacks, however, as the dynamics available 
from the keyboard were limited. As a further shortcoming, all 
reeds were damped on release, thus negating the possibility of 
obtaining sustain via a foot pedal. Despite these glaring prob-
lems, the sound of the model “T” Pianet was popularized by 
bands such as the Zombies and Small Faces, in the 1960’s.

In the years between the releases of the Pianet “N” and “T” 
models, Zachariah invented what was to become Hohner’s 
most successful, and certainly funkiest keyboard—the 
Clavinet. The Clavinet was designed to replicate the sound of 
a Clavichord, but with an altogether “fuller” sound. (The Clav-
ichord was notoriously ‘thin’ sounding)
46
Emagic
EVD6 



A Brief History of the Clavinet G
Original image from the D6 Users Manual.

The early models—Clavinet I with built-in amp, Clavinet II 
with tonal filters, Clavinet “L” with its bizarre triangular shape, 
all led to the Clavinet model “C”. This, in turn, was refined into 
the D6—a portable, amplifiable keyboard. The D6 used a 
hammer striking a string against a metal surface to produce its 
tone. It had a fully dynamic keyboard—as the striker is directly 
underneath the key, meaning the harder you hit, the louder and 
more vibrant the tone.

Mention the Clavinet today and most people will automatically 
think of Stevie Wonder’s “Superstition”—a recording that owes 
as much to the D6, as it does to the artist that wrote and 
performed it. The D6 was later superseded by the “E7” and 
the “Clavinet/Pianet Duo”. These were basically the same as 
the D6, but more roadworthy, quieter and better protected 
against proximity hums than previous models. 
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How the D6 Clavinet Works
Each D6 keyboard key forms a single arm lever. When a key is 
depressed, a plunger underneath touches the string and presses 
it onto an anvil. The string impinges on the anvil with a 
strength according to key velocity. This affects the dynamics of 
the sounding string. 

These mechanical vibrations are converted into electrical 
frequencies through magnetic pick-ups which are amplified 
and reproduced through the loudspeaker.

As the key is released, contact between plunger and anvil is 
immediately broken, leaving the wool-wound part of the string 
free, so that the string vibration is immediately muted.
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